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A.   ADMINISTRATOR MODE 

Creating a Resource 
1. Log in as administrator. 

2. Go to Administration, then to the Resource Module (Fig. 1). 

3. Click on “Management of resources” (Fig. 1). 

 
 
 
Fig. 1 

» Resources Module 
■  Search for a resource 
■  Management of resources 
■  List of language groups for resources 
■  Management of types of resources 
■  Management of keywords 
■  Management of themes 
■  Export the resource table 

  

4. On the new page, click on the link ■ Add a resource at the top of the page. 

5. Fill in the required fields marked with an asterisk, and add the resource or URL. 

a. Title.  By convention, use only necessary capitalization regardless of language, i.e., for 
proper nouns, names of places, etc. 

b. Author.  

i. By convention, write the first name initial in capital followed by a point and the last 
name in full, e.g., François Dunant > F. Dunant. 

ii. Separate multiple authors by commas. 

iii. If the author is an organization and its name is not too long, write the name in full; 
if the name is too long, or the organization is better known by its acronym, write 
the acronym in capitals (with the full name in the “notes” section, if necessary) in 
the resource’s language, e.g., World Bank or Banco Mundial, CEPES, UNDP. 

iv. When the author is the ILO, the following conventions exist in order to ensure 
uniformity and facilitate searches: 

 
For: 
 

Write: 

STEP Programme ILO-STEP 
BIT-STEP 
OIT-STEP 

SEC/SOC ILO, Social Security Department 
BIT, Département de la sécurité sociale 
OIT, Departamento de Seguridad Social 

Sub-Regional Office in 
New Delhi (M. Socquet) 

 
ILO-STEP SRO for South Asia 

or ILO SRO for South Asia 

 

c. Year. Four digits. 

d. Add the resource. 

i. Via the “browse” function. Wherever the resource is taken from, the system saves 
it elsewhere (large database) as if it made a copy. It is therefore not necessary to 
save all resources under I:\STEP\Platform\aGIMI\CONTENUS\… 

ii. Via the URL if the file is not available or you are only permitted to add a link. 

Important: For resources that are not ILO property, it is necessary to ask the 
proprietor for permission before publishing them on either platform – GIMI, GESS, 
AMIN or ACYM. Sometimes it is not enough that the author agrees that the 
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document is uploaded, as the rights may not belong to the author, but to the 
institution or organization that published the document. 

An example of an email requesting permission to upload a document may be found 
in Appendix 1 (page 10). Be sure to adapt the message. 

e. Add the cover image (see Appendix 2) at this point so that it is displayed immediately. If 
you add it later while editing the resource, it is displayed with a delay of several hours or 
days. 

6. Click on Submit at the bottom of the page. The system automatically assigns an id number  to the 
added resource. 

7. Go back to the administrator interface (resource section) to fill in the remaining fields. First, find the 
resource using the “find” function: Press Ctrl+F, write some of the title words and press Enter. Then 
click on “Edit” (Fig. 2 and 3). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NB. The id numbers on GESS are hyperlinks. Clicking on an id number gives immediate access to a 
page presenting the resource as it is viewed by users. Click on “back” in the web browser to return to 
the administrator interface. 

8. Fill in the optional fields . The fields are optional for users, but administrators must fill in all fields 
for which they have data. 

a. Add the cover image . For data size reasons, the image must be a .jpg file with a size of 
95X132 pixels. This corresponds to an A4 page. See Appendix 2 (page 11) for details. 

b. The Rank field. This is where users can evaluate resources by assigning stars (1-5 stars) 
to them. In administrator mode this field does not have to be filled in and is not active. 

c. The Size kb  field is filled in automatically. The size limit for a normal document (PDF, 
Word, PowerPoint, Excel, etc.) is 1 MB in order to provide quick download. 

Important: Do everything you can to reduce file size: convert to PDF with the lowest 
possible resolution (150 dpi if possible), reduce the size of photos, etc. Add a link rather 
than a file whenever you can. 

d. The ISBN and ISSN fields must correspond to the numbers given in some publications, 
written on the copyright page. It is increasingly common to have two ISBN: one for the 
printed publication and one for the electronic version (PDF). Both should be noted on the 
administrator form. 

e. The Editor and Published by  fields are not always easy to fill in and this information is not 
always necessary, especially when it is clear who the author is. For any questions, ask 
Ivón or Vicky. For official Social Security Department publications, refer to the document 
Guidelines for SECSOC Publications (PDF available in the GESS library and, for 
administrators, as a wiki accessible from the administrator homepage). 

Fig. 3 
GESS 

id number  

Delete the resource 
permanently 

Delete the resource 
permanently. 
 
 
 
Delete the file added (PDF, 
Word, etc.), but not the 
resource. 

 

id number 
Fig. 2 
GIMI 
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f. The URL Order field is useful for resources for sale that are not free to download, and 
where a URL exists to which users can be directed if they wish to buy the resource (e.g., 
books published by SECSOC). 

g. Themes . Get to know the GESS and GIMI themes in order to be able to categorize a 
resource correctly. 

h. Keywords . Be sure to choose good keywords. It is better to provide few that are 
representative than many that are vague or do not correspond well to the resource’s main 
topics. Often, it is enough to read the title, table of contents, introduction and perhaps the 
conclusions in order to find keywords. See the trilingual wordlist in Appendix 3 (page 14; 
subject to change). 

i. The field Select the pages on which the news will be displaye d is not active on GESS 
or GIMI, but is relevant for ACYM, AMIN and the Coordination Network (Concertation) 
sites. 

j. Language . One language per resource, i.e., one file per resource. If several versions exist 
of the same document, languages are managed using the language management form 
(see the point “o” below). 

k. In addition to the required fields, the “Published”, “Copyright” and “Activated” boxes must 
be selected for a resource to be displayed in the library. 

i. Select the Activated  box if the resource has been approved or recommended by 
a specialist (STEP field staff, Valérie, Christian, SECSOC staff, etc.) or if you 
consider the resource as concerning the GESS or GIMI themes. 

Important: Apart from the content’s relevance, make sure that resources do not 
contain anything that goes against ILO values. If in doubt, ask Valérie, Vicky or 
Ivón. 

ii. Select the Copyright  box if there is no problem with permission to upload the 
resource. 

iii. Select the Published  box if the two previous boxes could be selected and the 
whole form has been controlled. The person in charge of the library (Ivón) must 
activate added resources and select this box if everything is in order. The 
responsible person should therefore be notified by email (with the resource’s title 
and id number) about any added resources to be “published” in the GIMI/GESS 
library. 

Important: This box is different from the “Public” box on the form for adding 
resources from workspaces, which should only be selected if the workspace is 
public. 

l. The Related info field may contain very little text, and serves mainly to add links to 
additional information about the resource, either on other websites or in other documents. 
For instance, for the Coordination Network newsletter, a link might be added to the 
Coordination Network website. 

 

 

 

 

 

 

 

 

 

 

 

 

On the administrator form, HTML code must be used to add a link. An HTML editor has recently been 
added to make it easier to enter text. When adding an external link, it is important to include the tag that 

Fig. 3 
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opens the link in a new window, so the users do not leave GESS or GIMI. This principle is the same for 
any external link on the platforms. 

To do this, add the URL in question with the tag target=”blank”, by first clicking on “Source” and then 
inserting the tag manually, like this: 

 

 

 

 

 

 

 

 

m. The Note  field is for adding additional information about resources if there is any. In the 
field you can enter text of the same length as a summary (approximately 3000 characters, 
including HTML tags), other links, a contact person’s email address, etc. 

n. Following this there are four Summary  fields, one for each of the platform’s languages, 
plus one for a language that can be chosen from the drop-down menu above the field. 

The principle is to write the summary in the language of the resource, i.e., one summary 
per file, but there are special cases, e.g., if a document exists in only one language, but is 
so important that it is judged that users should at least have access to the summary in 
their language. In these cases a summary is added for one or more languages in the same 
file. 

Summary texts require some HTML code. In general, you can write letters with accents 
directly in the summary text box, and also copy and paste from Word, for instance, 
although the font and size may change. It is therefore better to first copy the text into 
Notepad and then to the text box. Check that it displays correctly and rewrite if necessary. 

See Appendix 4 (page 17) for advice on writing summaries/abstracts . 

o. Languages  of one resource. Groups of resources serve to create an automatic link 
between different versions of the same resource. 

For new resources or resources that exist in only one language, there will be two boxes 
like this at the bottom of the form: 
 0  Add 

In the left box, add the id number of the language group. Then, click “Add”. 

To create a group, go back to the administration page of the Resources module (see Fig. 
1) and click on ■ List of language groups for resources. You should see this page: 

 

 

 

 

 

 

 

On this page you can do two different things: add groups and remove groups. Removing a 
group does not mean removing the resource. If you need to delete a group you have to 
make the necessary changes to the resources that belonged to it: assigning the right 
number to them or deleting it as the case may be. 

Fig. 3 
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i. Click on Add a group and give it a name. To be able to find groups easily, it is 
recommended to: 

1. Give names that are short and make it easy to find the groups later on; 

2. Give names that consist of: 1) the type of document, 2) the acronym of the 
organization and 3) additional useful information if necessary. For instance, 
websites are named according to the type of resource + colon + the acronym 
or name of the organization (Web: Microfinance Gateway); 

3. Avoid putting resource titles in full, as this take up too much space and is not 
really practical. 

ii. Click on “Add” and then go back to check the group’s id number. Enter this 
number on the administrator form for the resources in question, in the space 
indicated in Fig. 5, and click “Add”. For instance, when the group id 131 is 
entered for all the relevant resources, the corresponding administrator forms 
should look like this: 

iii.  
Current group: 131  Remove 

 0  Add  version in FR id=2630 

 2630 

 2631 
 

French 

Spanish 

 

Remove 
Remove 

   

 Current group: 131  Remove 

  0  Ajouter  version in EN id=2550 

  2630 

 2631 

 French 

Spanish 

 

Remove 
Remove 

     

 Current group: 131  Remove 

  0  Ajouter  version in ES id=2631 

  2550 

 2630 

 English 

French 

 

Remove 
Remove 

The results of a search should display links to the resource in the other 
available languages, like this: 

 

 

 

 

 

 

 

 

Fig. 5 
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Checking the Results 
1. From the user homepage, it must be checked that the data are correctly displayed: correct font, line 

breaks and bullet points, links that work, cover image, etc. 

2. When adding resources to the library, it is recommended to work in two windows simultaneously: 
one to fill in the administrator forms and one in user mode to check the changes made. 

 

Editing Resources 
Considering the rising number of resources in the library, the full list has been split into pages with 20 
resources each (like the news), and the method for finding resources is therefore different (before you 
could press Ctrl+F). 

1. Finding resources that need to be activated or edited by exporting the table. To do this, go to 
Administration > Resources Module > Export the resource table (See Fig. 1). From the table 
(Excel), you can filter the data according to your needs: 

a. By the date the resource was created (added); 

b. By criteria: Activated=0, Copyright=0, Published=0; 

c. By the creator’s id number. 

Afterwards, go to the administrator interface and make the necessary changes. 

2. Finding resources that need to be activated or edited by using the search form, going to 
Administration > Resources Module: 

 

 

 

 

 

 

 

 

Click on » Search for a resource or » Management of resources > ■ Search for a resource (right-hand 
menu at the top of the page) and search according to relevant criteria: 

a. The resource’s id number if you know it; 

b. Part of the title; 

c. Name of the author; 

d. Country, etc. 

Make the necessary changes. 

 

Activating Resources Added by Users 
1. Log in as administrator. 

2. Find the resources by following steps 1 and 2 in the previous section, “Editing a Resource”. 

3. Revise the resources in question one by one, filling in all the fields. 

4. If everything is in order, select the three boxes: Published, Copyright and Activated. 

5. If you think it necessary, send an email to the (external) user to thank the person for contributing. 

6. Administrators for the various applications are responsible for adding and activating new resources. 
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Managing Folders, Directory I:\ (GIMI Geneva) 
Management of the library folders has begun for GIMI, which for this reason has a more complex 
structure. With the development of GESS, management is now in principle shared between the two 
platforms: on GESS, resources typical for GESS (extension of social security); on GIMI, resources 
typical for GIMI (microinsurance). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. General folder where all the resources in the library are saved. As mentioned in point 5.d.i, section 
1, it is not necessary to save all documents in this folder. 

This folder has three main subfolders: “documents principaux ” (no. 3), “images ” (no.8) and 
“résumés ” (no. 10). The latter is hardly in use anymore, since summaries/abstracts are written 
directly on the administrator forms. 

2. In this folder, all responses to requests for authorization to put material online are saved. 

3. Here, all principal documents (Word, PDF, Excel and PowerPoint files, etc.) are saved. Please 
note that films are saved elsewhere due to their size (ask Maxime). 

This folder has two subfolders: one for documents that have not been categorized (“avant 
classification”; no. 4) and one for documents that are heavy to convert (“lourds à convertir”; no. 6). 

4. Important: “Avant classification ”. In this folder, resources received from external contributors are 
systematically put, as well as resources you find yourself that have not yet been added to the 
library. As soon as the files are added, replace the original filename with the id number + the letters 
dp  and move the file to the “Fichiers docs principaux” folder (no. 3). Create subfolders if necessary. 

5. “Attente autorisation ”. If permission has been requested for putting a document online, add it to 
the library anyway and move the file to this folder. Create subfolders if necessary. 

6. “Documents lourds à convertir ”. An example is Marc’s documents, which often need to be 
converted to reduce size before they are added to the library. As soon as this is done, move the 
converted files (with the name changed into the resource id number) to the “Fichiers docs 
principaux” folder (no. 3) and the originals to the “Originaux lourds ajoutés ds biblio ” folder (no. 
7). Create subfolders if necessary. 

8. Here, cover images are saved. These files are in .jpg format and should have a size of 95X132 
pixels. They should be named after the resource id number, e.g. “2335.jpg”. 

File location 

1 
 
2 
3 
4 
 
5 
 
 
 
 
6 
 
7 
 
 
 
8 
9 
10 
11 
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9. This folder contains images belonging to documents that do not yet have an id number. As soon as 
this number is created, the filename should be changed into the id number of the corresponding 
resource and the file moved to the main image folder (no. 8). 

 

Managing Folders, I:\ Directory (GESS Geneva)  

 

 

 

 

 

In GESS there are only two folders: one for images and one for main resource files. 

When a resource is added to the library, the original filename should be changed into the id number and 
the file saved in the “Main resources” folder. Create subfolders if necessary. 

 

File location 
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B. USER MODE 

Creating a Resource 
1. Log in. 

2. From your personal space, go to the “Latest resources added to the library” section and click on 
“Add a resource”, or click on RESOURCES > LIBRARY on the horizontal menu at the top of the page, and 
then on Add a resource. 

3. Fill in the required fields. 

a. Title. 

b. Author. By convention, write the first name initial followed by a point and the last name 
in full, e.g., François Dunant > F. Dunant. 

c. Separate multiple authors with commas. 

d. Year. 

e. Region. 

f. Add the resource. 

i. Using the “Browse” function. 

ii. Entering the URL if the file is not available. 

g. Keywords. Add at least two keywords from the list. To add more than one keyword, 
select them with the mouse while holding down the Ctrl key. In the same way, to 
deselect a keyword if several are selected, click on it with the mouse while holding the 
Ctrl key. 

4. Fill in as many optional fields as possible. 

a. Subtitle. 

b. Type. 

c. Language. 

d. Theme. To select more than one theme, follow the same procedure as for keywords. 

e. Country. To select more than one country, follow the same procedure as for 
keywords. 

f. Summary. Option to add a summary in several languages (English, French, Spanish 
and/or a fourth language to be chosen from the drop-down menu). 

5. Click on Submit at the bottom of the screen. 

 

Important: Resources added by users need to be validated by administrators before they are published 
in the library (administrators, see “Creating a Resource, point 8k). 

6. Users will see a page listing their contributions: 
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Managing your contributions 
When users add a resource, they see a page listing all the resources they have added 
(http://www.ilo.org/gimi/RessShowUserRessource.do or ...gimi/gess/RessShowUserRessource.do) that 
have not yet been validated by an administrator and are therefore not published in the library. These 
appear under the “Resources waiting for validation” section. The resources are moved to the list under 
“Validated resources” as they are validated by administrators. 

By clicking on ■ More info…, users can see the presentation files for the added resources as they will 
be displayed after the resources have been validated and published (with adjustments made by the 
administrator, if necessary). They can also delete the resources by clicking on ■ Remove. As soon as 
resources are validated, users can no longer delete them, but they can add comments. 
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C. APPENDICES 

Appendix 1. Email Requesting Permission 
 

Dear …, 

 

The Social Security Department of the International Labour Office has, through its STEP 
Programme, developed an Internet platform on the extension of social security to 
disadvantaged groups: Global Extension of Social Security (GESS). 

The platform aims to be a comprehensive knowledge development system based, inter alia, 
on an Internet application and a network of experts worldwide. One means of attaining the 
platform's main objective is by producing, disseminating and capitalizing on relevant 
knowledge among experts and people interested in social protection issues. 

In this context, we hereby request your permission to add the following articles published by 
Elsevier to the platform's resource centre:  

1) "Adverse selection in a voluntary Rural Mutual Health Care health insurance scheme in 
China", by H. Wang et al., April 2006. 

http://www.sciencedirect.com/science?_ob=ArticleURL&_udi=B6VBF-4JT3S8G-
2&_user=1991186&_coverDate=09%2F30%2F2006&_rdoc=1&_fmt=&_orig=search&_sort=d
&view=c&_acct=C000055288&_version=1&_urlVersion=0&_userid=1991186&md5=c51b946f
2f3f241f7c40eefb91ec094b  

2) "Health care in China: The role of non-government providers", by Y. Liu et al., 2006. 

http://www.hsph.harvard.edu/phcf/publications/Liu.Berman.Yip.2006.pdf  

The articles would be accessible on the platform through links to the relevant websites listed 
above.  All references to Elsevier and to the articles' authors would be duly stated. 

Thank you very much for your attention. 

Looking forward to hearing your decision soon, 

[signature] 

 

------------------------------------------------------------- 

1. Present the platform. Adapt according to the platform in question. 

2. Refer to the publishing organization. 

3. Give the title(s) of the work + provide a link to the organization or publisher. Adapt according to the request 
in question. 

4. Mention how the platform will make the information available + assure that references will be stated 
appropriately. 

1 

2 

4 

3 



 12

Appendix 2. How to Add Images in the Library 
Two types of images are created and saved in the library: to illustrate resources and to add to generic 
pages (theme and country pages, wikis, etc.) or the glossary. Here only the first type is dealt with. 

���� Illustrating a Resource in the Library 

When you add a resource to the library you should also add an image to illustrate it. This is an important 
visual detail that makes it easier for users to recognize resources. 

Users rarely add images, as this is time-consuming. Sometimes they send an image file by email that 
the administrator can use to create the resource image. 

Which Image should be Added? 

The idea is to add an image that properly represents the resource. It can be different depending on the 
resource, e.g.: 

• For documents such as articles, newsletters, conference or workshop documents, ESS Paper 
series, books or case studies, the cover  should be added; 

• For websites, a screenshot  of the homepage may be added; 

• In some cases a logo or another visual  detail  from the resource may be added (provided that 
it is available in a good format, so that it is not blurry). 

What should the Characteristics of the Image be? 

• Default format: 95X132 pixels  vertical rectangle, i.e., approximately 2.5X3.5 cm (proportional 
to an A4 page (portrait)); 

• File type: jpg , which in this case will have an average size of 13KB . 

How to Create and Modify Images 

This will depend on the material you have at your disposal, but ideally the aim is to have an image that 
is small in scale and data size, correctly proportioned and has a legible title. 

This requires an image editor . Here, IrfanView  will be used. 

Follow the steps below for standard images , such as A4 (portrait) covers. 

If no electronic version is available, the image must be scanned : 

1. Place the document in the scanner. 

2. Open the IrfanView application, click on File > Acquire/Batch scanning (this opens the scanner 
window). 

3. Select the “true color” parameter and select the image (be careful not to go outside the 
document’s borders to avoid grey areas). 

4. On the menu bar, click on Tools and change the following parameters: 

- resize: Scale=50% 

- change resolution: 150 

5. Click on Return to (to go back to IrfanView). 

6. Resize the image by clicking on Menu > Image > Resize/Resample (keep the “Preserve aspect 
ratio” box selected): Width: 95 px, Height: 132 px. 

7. Click on Zoom and crop the image: Menu > Edit > Crop selection 

8. Save the image (see the reminder about file management at the end of the document). 

If an electronic version is available (e.g., a PDF, a PowerPoint presentation or a website), copy the 
image : 

1. Open the file and copy/paste the image into IrfanView. 

2. This is easiest for Word files, whereas for PDF files, you first have to: 

a. Open the file and zoom out to around 60%; 

b. Make a screenshot (Print Screen); 

c. Paste the screenshot into Paint; 
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d. Crop the image to get only the selection you want and then copy it. 

3. Open IrfanView and paste the image. 

4. On the menu bar, click on Image > Resize/Resample. 

5. Adapt the size in pixels (Set new size) and enter 95 for Width. 

 As the “Preserve aspect ratio” box is selected, the Height parameter should adjust 
automatically (132 pixels). 

6. Click on OK. 

 Important: Often the Height value will be greater or smaller than 132. 

a. If the Width=95 and the Heigth>132, go to point 7; 

b. If the Width=95 and the Height<132, enter 132 for Height. Width should then be 
greater than 95. Go to point 7. 

These values are displayed in the grey field at the bottom of the IrfanView window. 

7. Crop the image in order to fit it into the default dimensions and eliminate any grey areas. 

a. Zoom out sufficiently to have a good view (the true size does not change); 

b. Use the mouse to select the image by clicking in the lower right-hand corner and 
dragging towards the upper left-hand corner until the desired values are reached 
(these are displayed on the IrfanView title bar as you make the selection). Release the 
mouse button. 

 

 

c. On the menu bar, click Edit > Crop selection. 

8. Save the image. 

Follow the steps below for non-standard images , such as landscape format images (PowerPoint 
presentations – .ptt), brochures and websites. 

The main points are the same, but be careful not to deform the image. This example uses a .ppt file. 
With some practice the procedure can be adapted to other formats. 

1. Open a blank Word document (A4 (portrait) format) without margins , and name it 
“template_cover”. Press Enter three times on the page. 

Values with new 
selection. 

Initial values. 

Make the new selection 
by starting in the lower 
right corner. 

Zoom + 
Click several times 
(ca. 4-5) 
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2. Open the .ppt file, copy the page you wish to use as an image and paste it into word with the 
cursor on the second line. 

3. Enlarge and move the image (e.g., centre it vertically and horizontally) until it fills as much as 
possible of the page without being deformed. 

4. Important: After you have centred the image, press Enter until you reach the bottom of the 
page. If you do not, the proportions will not be maintained when you paste the image into 
IrfanView. 

5. Press Ctrl + A (to select everything, including the empty lines) and copy; then paste the 
selection into IrfanView. 

6. From here, follow the procedure for a standard image starting at point 4. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Adding Images on the Administrator Form 

1. When the cover image has been created, go to administrator form for the resource, add the 
image file in the appropriate field and click on Submit. 

2. In principle, images added by administrators are displayed immediately, but this may take from 
some minutes to some hours. 

Reminder: File Management 

1. If the resource is already in the library: 

a. Name the file with the corresponding id number; 

b. Save the file in the corresponding folder: 

…aGIMI\CONTENUS\PF_SPEC_Cres_033\Images or 

…aGESS\CONTENUS\LIBRARY\Cover. 

2. If the resource has not been categorized yet: 

a. Give the file a temporary name; 

b. Save it somewhere until the resource has an id number; 

c. Rename the file and move it to the corresponding folder. 

4. Move the image. 
Press Enter until you 
reach the bottom of 
the page. 

3. Enlarge. 2. Copy/paste original. 
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Appendix 3. Trilingual Lists of Themes, Keywords and  Types of 
Resources 
Keywords 

ES EN FR 

Generalidades, panorama 
(sobre el microseguro) Overview (microinsurance) 

Aperçu (sur la micro-
assurance) 

Articulaciones Linkages Articulations 

Seguro privado Private insurance Assurance privée 

Seguro social Social insurance Assurance sociale 

Campaña (de la OIT sobre 
seguridad social para todos) Campaign Campagne 

Desempleo Unemployment Chômage 

Contabilidad Accounting Comptabilité 

Contabilidad nacional National accounting Comptabilité nationale 

Convenios contractuales Contractual arrangement Contractualisation 

Contrato / convención Contractual agreements Contrat / convention 

Supervisión Supervision Contrôle / surveillance 

Convenio de la OIT ILO convention Convention de l'OIT 

Diagnóstico Diagnosis Diagnostic 

Niños Children Enfants 

Espacio proyecto sobre 
Senegal Senegal project space Espace projet Sénégal 

Estudio actuarial Actuarial study Etude actuarielle 

Estudio de factibilidad Feasibility study Etude de faisabilité 

Evaluación de necesidades Needs assessment Etudes des besoins 

Evaluación (de sistemas de 
microseguro, de seguridad 
social) Evaluation Evaluation 

Mujeres Women Femmes 

Financiación de la seguridad 
social Social security financing Financement sécurité sociales 

Funcionarios (empleados de la 
administración pública) Civil servants Fonctionnaires 

Género Gender Genre 

Administración Management Gestion 

Gestión del riesgo Risk management Gestion du risque 

Global Social Trust Global Social Trust Global Social Trust 

Impacto Impact Impact 

Discapacidad Disability Incapacité / invalidité 

Legislación Legislation Législation 

Mercadotecnia Marketing Marketing 
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ES EN FR 

Mercadotecnia social Social marketing Marketing social 

Maternidad Maternity Maternité 

Microseguros Microinsurance Micro-assurance 

Microfinanza Microfinance Microfinance 

Modelos Models Modèles 

Mutuales de salud Mutual health organizations Mutuelles de santé 

Normas OIT y legislación ILO Standards & Legislation Normes BIT et législation 

Oferta de cuidados de salud 
(asistencia, servicios médicos) Health care supply Offre de soins de santé 

Socio-agente Partner-agent Partner-agent 

Pensión de vejez Pensions Pensions de retraite 

Personas de edad avanzada Senior citizens Personnes âgées 

Pertinencia Relevance Pertinence 

Planes de acción nacionales National action plans Plans d'action nationaux 

Política social Social policy Politique sociale 

Prestaciones en metálico Cash transfers Prestations en espèces 

Proyecto sobre legislación Legislation project Projet législation 

Protección social básica Basic social protection Protection sociale de base 

Protección social de salud Social health protection Protection sociale en santé 

Recomendación de la OIT ILO recommendation Recommendation de l'OIT 

Redistribución Redistribution Redistribution 

Regulación Regulation Régulation 

Salud Health Santé 

Seguridad social Social security Sécurité sociale 

Social budgeting Social budgeting Social budgeting 

SPER SPER SPER 

Estadísticas Statistics Statistiques 

Estrategias nacionales National strategies Stratégies nationales 

Seguimiento Monitoring Suivi 

Sistemas de base comunitaria 
(basados en la comunidad) Community-based schemes 

Systèmes à base 
communautaire 

Third-party administrators 
(TPA) 

Third-party administrators 
(TPA) 

Third-party administrators 
(TPA) 

Obreros del transporte Transportation workers Travailleurs des transports 

Trabajadores migrantes Migrant workers Travailleurs migrants 

Trabajadores rurales Rural workers Travailleurs ruraux 

VIH / SIDA HIV/AIDS VIH / SIDA 
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Themes 

ES EN FR 

Generalidades, panorama 
(sobre el microseguro) Overview (microinsurance) 

Aperçu (sur la micro-
assurance) 

Articulaciones Linkages Articulations 

Seguro social Social insurance Assurance sociale 

Convenios contractuales Contractual agreements Contractualisation 

Viabilidad (estudio de 
factibilidad) Feasibility Faisabilité 

Financiación Financing Financement 

Administración Management Gestion 

Global Social Trust Global Social Trust Global Social Trust 

Legislación / Regulación Legislation/Regulation Législation / Régulation 

Mercadotecnia Marketing Marketing 

Microseguros Microinsurance Micro-assurance 

Normas OIT y legislación ILO Standards & Legislation Normes BIT et législation 

Pertinencia Relevance Pertinence 

Políticas y estrategias 
nacionales National polices and strategies 

Politiques et stratégies 
nationales 

Prestaciones en metálico Cash transfers Prestations en espèces 

Prestaciones universales Universal benefits Prestations universelles 

Protección social en salud Social health protection Protection sociale en santé 

Asistencia médica Health care Soins de santé 

Estrategias / Planes de acción Strategies/Action plans Stratégies / Plans d'action 

Seguimiento-Evaluación / 
Diagnóstico rápido 

Monitoring-Evaluation/Rapid 
appraisal 

Suivi-Evaluation / Diagnostic 
rapide 

Sistemas articulados Linked schemes Systèmes articulés 

 

Types of Resources 

ES EN FR 

Artículo (prensa u otro) Article Article 

Convenio (con prestadores 
de servicios médicos) / MoU 

Agreement/MoU 
(Memorandum of 
Understanding) Accord offre de soins 

Taller (documentos sobre) Workshop Atelier 

Base de datos Database Base de données 

Folleto Brochure Brochure 

Conferencia (documentos 
de) Conference Conférence 

Convenio de la OIT ILO Convention Convention de l'OIT 

Documento de trabajo Working paper Document de travail 
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Expediente (varios 
documentos sobre un mismo 
tópico) Dossier Dossier 

ESS Paper series ESS Paper series ESS Paper series 

Estudio de caso Case study Etude de cas 

Película (video) Film Film 

Guía / manual Guide/manual Guide / manuel 

Entrevista Interview Interview 

Inventario Inventory Inventaire 

Boletín informativo Newsletter Lettre d'information 

Libro (o capítulo) Book (or chapter) Livre (ou chapitre) 

Programa informático Software Logiciel 

Módulo de capacitación Training module Module de formation 

Presentación power point Presentation Présentation 

Informe Report Rapport 

Artículo científico (informe) Research paper Rapport scientifique 

Sitio Internet Website Site internet 

Texto jurídico Legal text Texte juridique 
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Appendix 4. Guidelines for Writing Summaries/Abstrac ts 
Excerpt from Labordoc Indexing Techniques, Unit 4: Free Text Abstracts, 
http://www.ilo.org/public/english/support/lib/tools/indexing.pdf (May 2005) 

Chief characteristics of a good abstract: 

Essentiality : 

The abstract should focus on the essential content, or emphasis, of the document, distinguishing the 
essential from what is peripheral.  

Objectivity : 

The indexer must neither introduce biases nor evaluate, interpret, or draw conclusions from the material. 
Objectivity implies that the indexer avoids qualifying the document as “excellent”, “unusual”, 
“authoritative”, etc. For example, the author of a document may claim to be describing a “unique” 
phenomenon, but we cannot accept his or her claim without proof. He or she may only be trying to make 
the research sound more interesting.  

Accuracy : 

The abstract must accurately reflect the content of the document.  

Clarity : 

The abstract must be clear and precise in its meaning, both as a whole and in its individual sentences. 
The reader should never be puzzled by what an abstract is attempting to convey. 

Concision : 

An abstract is a condensation and is limited in length. The indexer should always use the most 
economical means of expression.  

Style : 

The overall style of the abstract should be formal: slang expressions and contractions should be 
avoided, and complete sentences should be used, except for verbal phrases such as: “Describes...”  

The abstract may summarize a portion of the documen t only , rather than the document as a whole.  

Sometimes, one of the subjects covered in a document needs to be explained in a free text abstract, 
while other subjects covered in the same document do not need any explanation. However, if the 
abstract deals with only one of several of the document’s subjects, this subject could take on too much 
importance. 

The solution to this is to use a phrase that shows the reader that this subject is not the main or only 
subject covered, such as: “Takes into account...”, “Briefly examines...”, “One chapter covers...” or 
“Includes a chapter on...” 

A different approach  consists in writing the abstract responding to the following questions: 

1. What is the objective and the field of the resource or document? 

2. How is it structured? 

3. Whom does it address? 

This type of abstract can be used for guides or manuals, for instance. 

---------------------------------------------------------------------------------------------------------------- 

 

The ELDIS portal contained a section on abstracts for its users until 2006 (it appears that we no longer 
have access to it). A short transcription follows: 

 

Writing the perfect abstract 

Content 

Imagine that you are a researcher or policy maker, looking at an abstract on the internet or in an e-
mail: 

• How much time do you have to read it? 

• Does it catch your eye? 
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• Does it look interesting? 

• Does it tell you what you need to know? 

 

What do you need to know about the document? 

• How it fits into what you already know; 

• Whether it offers anything new or different; 

• What changes it suggests to current thinking; 

• What it can help you to do. 

 

Writing for the Internet 

• The abstract will be read on screen and will be e-mailed to subscribers; 

• Internet users are notoriously impatient; 

• Policymakers and practitioners are generally very busy and need information fast; 

• They know a lot about their subject – they do not need general introductions; 

• They do not want to read something they already know. 

 

The Full Abstract 

Purpose: to let you decide if you should read the document. Is the document new/interesting? Is it what 
you are looking for? The abstract will not replace the need to read the actual document. 

We expect different types of documents to require different types of abstracts; for instance, policy 
briefing abstracts will be different from practical manual abstracts. 

Length: about 400 words. More if the message is complicated or there are multiple messages: The 
abstract will be read on screen or in an e-mail and not in a book, so it needs to be short. However, if you 
think that the abstract (if slightly longer) can replace the need to see the actual document, make it 
slightly longer. 

Style 

• The focus of the abstract is the conclusion of the paper, not the introduction, which usually 
contains well-known general information. What does the paper actually say? What are its 
recommendations and conclusions? 

• The abstract needs to contain keywords for search purposes. 

• Write as clearly and as simply as possible. 

• Keep sentences short and do not use unnecessary words, e.g., adjectives and adverbs. 

• Do not repeat ideas or concepts. 

• Remove advertising by the author/publisher, e.g., “This is the most important paper on this 
subject for the last ten years…” 

• Write in the present tense. 

• Write in third person and rewrite personal pronouns, e.g., authors’ “we then looked at…” 
Instead, write “the article looks at…” or “looks at…” 

• Break into short paragraphs, each focused on a concept. Subdivide these using bullet points 
to highlight conclusions of the research. Can be multiple bulleted lists (e.g., if there are 
separate (and interesting) lists of factual findings and policy conclusions/recommendations). 

• Highlight using bold, not italics (HTML code: <b>, </b>) 

• When writing an abstract, the best places to look f or information in the document 
include its own abstract (if available; but note th at author abstracts do not always 
include conclusions) and the executive summary, int roduction and conclusions 
sections. 


